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Introduction 
 
Welcome to the freeware Aquarius Database, which you can customize to your business 
or organization, and use for as long as you like, for free. 
 
Getting started is easy: 
 
1) Click the ‘Help’ button on the main window, then click ‘Sales’, ‘Find Product’, etc., to 
read the User Help topics. 
 
2) Play with the ‘High Mountain Hardware’ sample database. Click ‘Find Product’ to see 
the products and their codes. Make a few sales. Click 
‘Management’, which shows the menu bar, view the reports, and select 
‘Edit Customers’ to see what it’s about. It doesn’t matter what you do to this sample 
database, so feel free to experiment! 
 
3) Follow the easy instructions in the Help Menu topic ‘Setting up your working 
database’ to quickly set up Aquarius for your business. 
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Setting up your working database 
 
After familiarizing yourself with the ‘High Mountain Hardware’ sample database, and 
carefully reading this help topic, proceed as follows to set up a working database for your 
business or organization: 
 
1) From the File menu click ‘Working database’. This switches Aquarius to a new empty 
database which has the same structure as the ‘High Mountain’ database, but has no 
information in it. You will notice that the business name, above the command buttons, 
has changed from ‘High Mountain Hardware’ to ‘Your Business Name’. You can switch 
between the ‘Working database’ and the ‘Sample database’ at an y time, simply by 
clicking on the one you want in the File menu. 
 
2) Click on ‘Setup’ from the ‘Customize’ menu. In place of ‘Your Business Name’, type 
in your actual business name; you will see it change on the main form as you type it in. 
Then fill in the rest of the 
‘Essential setup’ section. The ‘Short business name’,  ‘Thanks  
message’ and ‘Phone number’ will appear on your small cash -register type receipt. 

Password: 
3) Enter a password only if you want to restrict access to the management functions. 
Make sure you write it down and keep it filed away somewhere safe, in case you forget it. 
(If you do forget and lose your password, you can find out what it is by loading the 
database 
(‘AqData.mdb’) into MS Access and looking at the ‘ Password’ field of the ‘Setup’ table.)  
 
4)  The ‘Default salesperson’ will be the name listed in the ‘Salesperson’ field when you 
make a sale; it can be changed each time you make a sale, for that sale, if the person 
making the sale is not the default person. You can also change the default salesperson as 
often as you like, such as at the beginning of each shift. 
 
5) The ‘Default tax rate’ is the sales tax rate, or the most common sales tax rate, for your 
state. See Note 2 on the form on how to enter it. It will be used to set an initial value for 
the ‘Tax Rate’ field in the  
‘Edit Products’ form when you enter your product details; you can enter different tax 
rates for different products if you need to. 
 
At any point you can click the close button (‘X’  at top right) to save the changes you have 
made. You can then continue the setup at a later time. 
 

Word processor setup: 
 
If you have MS Word 97 or later, and it is present on your computer at the path shown 
(the most common place) then don’t touch anything in this section. If Word is present on 
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a different path, type that path in, and double check you have it right. If you don’t have 
MS Word 97 or later, then leave this for now, and read the later Help Topic on ‘Using a 
different word processor’. You can use Aquarius without a word processor being set up 
for it, however, certain features that invoke the word processor, such as printing an 
invoice, will not work. 
 
If using print functions which call Word (like printing an invoice) invokes your virus 
scan program, this is how to get around it: click “Customize” then “Setup”, then delete 
the “%+n” from the “WP mail merge” field. This command, “Alt + Shift + n” creates the 
mail-merged documents from the master document, but in one anti-virus program also 
calls up a virus scan. Deleting it means you will have to click the “Merge to new 
document” button on the Word Mail Merge toolbar yourself — not too hard to do! 
 

Appearance: 
 
You can, at any time, change the photos in the main and help windows if you wish. To do 
so: 
 
1) Resize or crop the photos (or other art work) so they are fractionally larger than the 
windows they are to fit into (measure them with a ruler against your screen). 
 
2) Copy the photos into the ‘AquariusDB’ folder.  
 
3) Enter the names of the photos in the text boxes provided in the 
‘Appearance’ section of Setup. As soon as a correct name has been entered, the photo 
will show. 
 
If a photo is not as clear as it should be, and/or blocks of pixels stand out, then you may 
not be using the optimum color setting on your computer. To check, right click the 
desktop, then click ‘Customize desktop’ and choose the ‘Settings’ tab. The color setting 
should say 
‘True color, 32 bit’. If it is set to 256 colors or 16 b it color, then select 32 bit color from 
the drop-down box and click OK. You may have to restart your computer before the new 
color setting will come into effect. (Note: if you play DVDs on your computer, you may 
have to switch back to a lower color setting when using your DVD player.) 
 
Check the ‘Transparent buttons’ box to see what instantly happens to the command 
buttons on the main window. Uncheck the box to return to the original look. Leave it 
whichever way you prefer. 
 
Check the ‘Customers button’ box  if you want to have a button to click on the main 
window to get to the ‘Customers’ window. The ‘Customers’ button will replace the ‘Add 
Inventory’ button, and an ‘Inventory’ command will appear on the Edit menu instead, in 
place of the ‘Customers’ command , to allow you to access the ‘Add Stock to Inventory’ 
window. This is a good change to make if you consult your customer file a lot. 
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Leave the ‘Left margin on receipt’ as it is for now. If, when you print out a ‘cash register’ 
(small) receipt, on making a sale, the printout is not properly centered, you can change 
this setting to center it. (Eg: if the text needs to move 0.5 inches to the left, change ‘2.5’ 
to ‘2.0’.)  
 
This completes the setup of the ‘Working database’ to your business. Click to close 
button (‘X’ at top right) to exit and save the information you entered. Now you need to 
enter data about your products, suppliers and customers into the database. 
 

Entering Supplier Data:  
Click ‘Suppliers’  from the Edit menu to add details about the companies that supply the 
products you sell. If you sell a service, or manufacture all the products you sell, you can 
skip this section, and leave the Supplier table with the one entry it initially has, ‘Self’ 
which is there to cover these self-supplied products and services. 
 
Note: you cannot delete the ‘Self’ supplier unless you add at least one other supplier first. 
Aquarius does not work properly without there being at least one supplier in the Supplier 
table, so deleting the last supplier is not allowed. 
 

Entering Product Data: 
 
Click ‘Products’ from the Edit menu to add records for each of your products or services.  
 
Click the ‘New Record’ button, then enter the data for a product.  
 
The Product Code can consist of numbers or letters or a mixture of both. Letters can be 
entered lower case, but will be converted to upper case. Each product code must be 
unique, or the record you create will not be added. The various display boxes for product 
codes in Aquarius have been made wide enough to show codes 13 numerals wide, so 
make sure your codes are no longer than this, or shorter if they contain letters.  
 
Be consistent with your Descriptions. It will help product searches if 
you start with a general description, then get more specific, eg: 
‘Hammer; claw, fiberglass handle’. Limit the length of your descriptions to the length of 
the box provided if you want to avoid overflows onto another line in some of the 
displays. 
 
The Critical Stock is the level at which you wish to reorder the product. For instance, if 
you think it’s a good idea to reorder your claw hammers when you have 3 left, so as to 
avoid running out of them and losing sales, then set the critical stock to 3.  The 
Purchasing Report will then include this product when its stock level drops to 3 or below. 
Monitor the stock level when shipments arrive; if you find you regularly still have more 
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than one item of a product when the new shipments arrive, you could consider lowering 
the critical stock level. The Critical Stock levels can, of course, be adjusted at any time. 
 
The Actual Stock is the number you have in stock now. The Num. Purchased and Initial 
Stock can be left at 1 for now; Aquarius will automatically record these values in future 
when you make purchases. 
 
Choose the  Supplier by clicking the arrows [<] [>] to the right of the display box. If the 
supplier of this product is not in the list, you will need to go to ‘Edit Suppliers’ and add 
it. 
 
The Cost is what your supplier charges you for this product. This is used by Aquarius, 
along with the Price (your selling price) to calculate your gross profit in the Sales Report. 
This information is recorded for each sale, so when costs and prices change, the new 
costs and prices only apply to sales made after the change. 
 
Leave the Ordered field blank; it is used by the Purchasing Report. 
 
The Pic/Loc field can contain both the name of a picture and location information. 
1) If you have an electronic photo of the product (.JPG or .GIF), put the name of the 
photo, e.g. ‘T101.jpg’ (must not contain any spaces), in the Pic/Loc field. Resize or crop 
the photo to 320 × 240 pixels, and copy it to the AquariusDB folder. Products with 
pictures show in the Product Lookup form with an ‘*’ at the end of their description, and 
clicking on these descriptions will display a photo of the product. 
2) To add a location description, leave a space after the picture name then type the 
location code or description, which can contain spaces. Lookup will then show a ‘*·’, and 
the location description will be shown along with the photo. 
3) To put a location description in without having a photo, type a leading space followed 
by the location description. In this case, Lookup will show the product description 
followed buy a ‘·’, and, on clicking it, the location information will be displayed without 
a photo. 
 
Importing product data: If you have a sizable number of products, have had them stored 
in another database or spreadsheet, and can export them as a ‘delimited text file’, you will 
most likely be able to save a lot of tedious data entry by importing the data into Aquarius. 
See the Help Topic on ‘Importing and exporting data’ for details on how to do this.  
 
 

That’s it! 
 
When you have entered your products into the Products table, you are ready to use your 
new Aquarius database to make sales! 
 
You can enter your customers into the Customers table (with Edit Customers), but this is 
not essential, as you can enter customers as you go, when you make sales to them. 
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You can also edit the Banner Messages and Custom Help to display whatever you like for 
the benefit of yourself and your employees, but if you leave them as they are the database 
will work perfectly well for you. You can make these changes at your leisure. 
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Making sales 
 
Click the ‘Make a Sale’ button, and type or scan in, or pick from the dropdown list, the 
product code for the first sale item. When a correct product code is entered, its 
description appears to its right. The dropdown list of codes can be shown (or hidden) by 
pressing the space bar when the insertion point is in the code box. It also shows all 
matching codes as you start typing in a code, so you can pick one and not have to type the 
whole code in. To pick a code from the dropdown list, click on the gray selection box to 
the left of the code. You can drag the bottom edge of the ‘Make a Sale’ window down to 
increase its size and the number of lines the code dropdown list shows. 
 
Press the Enter key to move to the Qty. box, and enter the number of this item being 
purchased. Press Enter again. 
 
Repeat the above for each item in the sale. When there are no more items to enter, press 
Enter twice and type in the Salesperson’s name.  
 
Enter the order number if there is one, then the sale type. 
 
The next line is for making change in cash sales. 
 
In the final box there are four possible entries: 
 
- leave as ‘n’ to enter the sale and not print a receipt.  
- type ‘y’ to enter the sale and print a small cash register receipt.  
- type ‘a’ to do an ‘ account’ sale to a named customer.  
- type ‘c’ to cancel the sale  
 
Then click the ‘Enter Sale’ button to process the sale.  
 
If you choose to do an ‘Account’ sale, the ‘Edit Customers’ form pops up. Start typing 
the customer’s name into the ‘Part of Field’ b ox to see if the customer is already there. If 
not, click ‘New Record’ to add the customer.  
 
With the customer record showing, either: 
 
1) click ‘Receipt’ if the customer has already paid, or  
2) click ‘Invoice’ if the customer has an account with you.  
 
Your word processor will be invoked and will show the receipt and mailing label, or 
invoice, packing slip and mailing label. Check all the details are correct, then print them. 
Close the word processor windows (and don’t save them unless you have a good reaso n 
to). 
 
Finally, close the ‘Edit Customer’ window, and click ‘Enter Sale’.  
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Changing the layout of your Receipts and Invoices 
 
You will need to change the layout of the receipts and invoices, initially setup for ‘High 
Mountain Hardware’, to how you want t hem to be for your business. This is easily done. 
  
To edit the receipt layout, make a sale (it doesn’t have to be an actual one, as you can 
cancel it later instead of entering it), and make it an ‘Account’ sale, as described above. 
Click ‘Receipt’ from th e ‘Edit Customers’ window. A receipt called something like 
‘Form Letters1’ should be produced in Word (if it isn’t, see the Help topic ‘Setting up 
your working database’ to get it working). Close this file, and the mail merge document, 
called ‘AqReceipt.doc’, will then be showing. Make the changes you need to the wording 
of ‘AqReceipt.doc’, and replace the mountain logo with a picture of your company logo 
if you like, then save the file. You can get as creative as you like, as you have all the 
power of Word to make it look the way you want it to. This is what your customers see, 
so you want it to look good! 
  
To edit the Invoice layout, click on ‘Invoice’ from the ‘Edit Customers’ window, and in a 
similar way edit ‘AqInvoice.doc’.  
  

Returns and other changes to sales 
  
To change a sale after it has been made and entered, such as to cancel it when goods are 
returned, or to correct an error made in entering the sale, click on ‘Management’ 
(entering the password if required), then 
‘Edit’  and ‘Sales/Items’. This form enables you to add or delete items from a sale, or to 
delete a sale altogether. 
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Finding a Product 
 
If a customer inquires about a product, you can use the ‘Product Lookup’ form to help 
you find the exact product they are looking for, its product code, price, the number in 
stock, a description, and, if available, even a photo of it and its location. 
 
Clicking the ‘Find Product’ button brings up the ‘Product Lookup’ window. Type a few 
letters of any word that might be in the product description until you see the product you 
are looking for. 
 
You can use the wildcard character ‘*’ in the description to  stand for any group of 
characters. So, typing the product description ‘pa*50’ in the sample database will bring 
up the product ‘Paint brush; 50 mm pure bristle’ (‘*’ takes the value of all the characters 
between ‘pa’ and ‘50’, in this case ‘intbrush; ’). This, as you can see, enables you to 
search for the first few letters of more than one part of the description. In effect it says: 
‘search for these characters and these other characters and ignore anything in between.’ 
This can be very useful. For instance, if you had a large variety of paint brushes in stock, 
and a customer wanted a 50 mm brush, the ‘pa*50’ search would bring up a list of just 
those that were that size, so you could explain the choices to the customer. 
 
If the description ends with an ‘ *’, then clicking on the description  will display a photo 
of the product. If it ends with a ‘ ·’, then clicking on the description will show the 
product’s location (e.g. which shelf in the store or warehouse). If it ends with ‘ *·’, 
clicking it will show both the photo and the location.  
 
Use  this window whenever you need to find the product code, price,  stock level, 
illustration or location of an item. For instance, you can use it while making a sale. It’s 
OK to have both windows open at once; in fact, when you enter the sale, you will see the 
stock level on the ‘Product Lookup’ form automatically update itself. You can drag the 
lower edge of the window to increase its size to show additional entries. This new size 
will be remembered during the current session (until you close Aquarius). 
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Adding Stock to the Inventory 
 
When new stock arrives from one of your suppliers, it must be entered into the Aquarius 
database by clicking the ‘Add Inventory’ button and filling in the product code and the 
number of items of it being added to the inventory, for each product. 
 
Type the product code into the code box, and check that the correct description shows. Or 
a dropdown list of codes can be shown (or hidden) by pressing the space bar when the 
insertion point is in the code box. It also shows all matching codes as you start typing in a 
code, so you can pick one and not have to type the whole code in. To pick a code from 
the dropdown list, click on the gray selection box to the left of the code. You can drag the 
bottom edge of the ‘Add Stock to Inventory’ window down to increase its size and the 
number of lines the code dropdown list shows. 
 
If the stock level prior adding the new stock is greater than one or two, consider whether 
you want to go to ‘Edit Products’ and reduce the ‘Critical Stock’ level to save on 
inventory costs. Likewise, if the stock level has fallen to zero or below (back ordered), 
you may be wise to increase the Critical Stock level to avoid losing sales of this product. 
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The Purchasing Report 
At regular intervals, prior to purchasing new stock, run the ‘Purchasing Report’. With the 
Menu bar showing (click ‘Management’ if it isn’t showing), select ‘Purchasing Reports’ 
from the ‘Reports’ menu.  
 
Listed on each page of the report are the products which are at or below their critical 
level, which are supplied by the supplier shown at the top of the page. These are products 
that need to be reordered to avoid running out of stock of them. All the relevant 
information needed to reorder the products and decide how many to reorder is presented. 
Once you have placed the order for a product, you can click on the ordered column, upon 
which ‘Yes’ will appear in that column. You can show just the unordered items by 
checking the ‘Hide Ordered?’ box.  
 
You can change the ‘Critical Stock’ level of a product from this form. See the section on 
‘Adding Stock to the Inventory’ for a discussion on when and why you should do this.  
 
To see other pages of the report for products from other suppliers, click the [>] button on 
the ‘Suppliers’ data control to move to the next page.  
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Sales Reports and tax time 
 
Clicking on ‘Sales Report’ from the ‘Reports’  menu gives a form showing sales and 
profit figures broken up in a number of different useful ways to help you analyze your 
business’s performance. There are two sets of radio buttons to select from on the form: 
one set enables you to determine the period being reported on, the ‘Last year’ option 
giving figures you can use to help prepare your income tax return. The second set of 
radio buttons determine how the ‘Sales Figures by Product’ are sorted.  
 
The ‘Total Sales’ figure can be used on your income tax r eturn if all your sales have been 
made through your Aquarius database; if you have made additional sales not entered into 
Aquarius, you can add them to the ‘Total Sales’ figure to give you the figure to enter on 
Schedule C (Form 1040) Question 1: ‘Gross receipts or sales’. Note: the Sales Report still 
counts written off sales as sales, just as if they had been paid. This is so the report can 
reliably be used to provide the figures you need to do your tax return, which requires you 
to state your total sales including those not paid for, and to claim bad debts separately as 
a cost. 
 
Although the sales report ‘Gross Profit’ figure gives a good indication of gross profit, you 
cannot use it on your tax return. The IRS requires you to calculate the cost of goods sold 
from actual physical stock takes to determine the number of stock items used up during 
the year. This is to your advantage, though, as the cost of damaged and stolen items and 
samples given out can be claimed in addition to the cost of items sold, and this reduces 
your tax liability. Aquarius, on the other hand, only takes into account the cost of goods 
sold in determining its estimate of ‘Gross Profit’.  
 
The ‘Sales Tax’ figure is the total sales tax collected during the selected period, so it can 
be used to determine the amount of sales tax to be remitted providing all sales taxable 
sales during the period were entered into Aquarius. 
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Managing Unpaid Accounts 
 
The ‘Unpaid Accounts’ report from the ‘Reports’ menu shows all sales that have been 
made with the ‘i’ (Invoice) payment method. As you receive payments for accounts, run 
this report and click the sale being paid in the ‘Pay Method’ column. The ‘i’ will change 
to ‘ip’ (Invoice paid), and this sale will not be shown in the report in future. What will 
show is all the unpaid invoices. Selecting a sale by clicking it in a column other than ‘Pay 
Method’ will show how many days it h as been since the sale was made, and who the 
contact person is. The invoice number, date of sale, value of sale, customer name and 
phone number are all shown in the list so you have, in one window, all the information 
you need to chase up payment. If you click an ‘ip’ it will change to ‘iw’, which you can 
use to indicate an ‘Invoice written off’, for payments you have given up trying to collect. 
(Clicking an ‘iw’ will cause it to revert to an ‘i’ again.)  
 
The Sales Report still counts written off sales as sales, just as if they had been paid. This 
is so the report can reliably be used to provide the figures you need to do your tax return, 
which requires you to state your total sales including those not paid for, and to claim bad 
debts separately as a cost. At tax time (or any other time) you can quickly find written off 
sales by going to ‘Edit Sales,’ clicking the radio button for ‘Pay Method’ filter type, and 
typing ‘iw’ into the Filter box. You can then use the selector bar to click through the 
written off sales to get the value of the sales (including tax) for these sales and the 
amount of tax not collected for them. This information can then be used to claim bad 
debts as a cost on income tax and sales tax returns. 
 
If you get any bad checks, and have to write off sales because of them, you could go into 
‘Edit Sales,’ find the sale, and change the Pay Method from ‘ch’ to ‘chw’. You could 
then search for both ‘iw’ and ‘chw’ sales to find all your bad debts by typing ‘*w’ into 
the filter box. 
 
When you have claimed bad debts in a tax return, you could mark the pay methods as 
‘chx’ or ‘ix’ so you have a record of them (and can search for them with ‘*x’), but so 
they don’t show when using the ‘*w’ search at tax time in subsequent years.  
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Edit Customers, Products, etc. 
 
Their customer database is one the most valuable things any business possesses. This 
form is designed to keep track of this asset. You can enter your customer details one 
record at a time as you make sales to them, or you can enter most of your customers in 
advance. If you already have a customer file in another database or spreadsheet, and you 
can export the data from that source to a delimited text file, then you can import the data 
into the Aquarius customer table, and avoid a lot of tedious data entry. See the help topic 
on ‘Importing and exporting data’ for details on how to do this.  
 
Each customer must have a unique name. The name field holds the whole name, rather 
than having separate fields for first, middle and last names. This saves having to have a 
separate customer identifier, and doesn’t, as we shall see, prevent us from being able to 
access the first and last names separately, or import from delimited text files where the 
parts of the name are separated. 
 
To find a customer, with the field name set to ‘Name’ and the operator to ‘contains’ (as 
they initially are), enter as much of the name as you need to into the ‘Part of Field’ box to 
bring up the customer record you want. The wildcard character ‘*’ can be used in the 
‘Part of Field’ box to stand for any group of characters, to help in complex searches. You 
can also search on any other field by clicking the down arrow and selecting the field you 
want from the drop box. You can likewise select from a variety of different operators to 
help refine your search. For instance, you may remember the town a customer lives in, 
but not his name. So you can search for ‘Town’ ‘=’ . The  
‘Selected’ box will show you how many records meet this criterion (customers in this 
town). If there is more than one, you can scroll through the selected records by clicking 
the [>] button on the 
‘Customers’ data control, until you recognize the name you want. 
 

Print Command Buttons: 
Across the bottom of the Customers form are four command buttons: 
‘Envelopes’, ‘Letters’, ‘Labels’, and ‘Addr. List’. These use your word processor’ s mail 
merge facility  to print envelopes, form letters, mailing labels and address lists for the 
customers currently selected, or for those you have tagged (by checking the ‘Tag?’ box) 
if any are tagged. You can tag from more than one selection if you wish to: make an 
initial selection (by specifying the criteria you want), tag some customers from within 
that selection, then make another selection, and tag customers from within it, and 
envelopes, etc. will be created for all the tagged customers from both selections. If no 
customers are tagged, envelopes, etc., will be produced for all the customers in the 
current selection. 
 
The first time you use each of these buttons, you will need to modify the master mail 
merge document so it contains the right information for your business. For instance, 



 

 

16 

 

when you click the ‘Envelopes’ button, initially the return addresses on the envelopes 
will be for ‘High Mountain Hardware’. To change this, close the merged document  
(‘Envelopes1’), then the master document ‘AqEnvelop es.doc’ will be showing. Enter the 
correct return address for your business, then save the document. In future, all envelopes 
will have this new return address. When you first use the other print buttons, go through a 
similar process to make any needed changes to their master documents. You can also 
insert new or different merge fields from the list your word processor provides, and this 
includes separate merge fields for ‘FullName’, ‘FirstName’ and ‘LastName’, enabling 
you to use just one part of the name if you wish to. 
 
If by some chance the mail merge process is not working correctly, see the Help topic 
‘Setting up your working database’ to get it up and running properly.  

 

Editing Products, Sales, Suppliers, Banner & User Help: 
 
Edit Products enables you to enter product details, and change them whenever you need 
to. You can use the wildcard character ‘*’ in the product code filter to stand for any group 
of characters, to help you select a particular group of products. Clicking the ‘Make 
Catalog’ button uses the mail merge feature of the word processor specified in Setup 
(initially MS Word) to create a product catalog of the selected products. You can adjust 
the mail merge master document to format the catalog in any way you like. The catalog 
will be in product code order unless you check the ‘Order by desc.’ box, in which case it 
will be ordered by product description. See the help topic ‘Setting up your working 
database’ for more information on using this form.  
 
Edit Sales/Items lets you change the details of a sale. This could be useful when an error 
is made in entering a sale, or when a customer returns on item. Enter the receipt number 
in the Rt. ‘Filter box’  to move to sale you want. You can also filter by Customer or Pay 
Method by clicking the appropriate radio button. Note that you can’t delete all the items 
in a sale; to do that, delete the sale itself. 
 
Edit Suppliers is used to add new supplier information and edit what is there. Some 
supplier information can also be changed on the Purchasing Report form. 
 
Edit Banner Messages allows you to add to, change or delete the banner messages 
which are displayed at the bottom of the Aquarius window, so they are relevant to your 
business or organization. 
 
Edit User Help allows you to specify exactly what is displayed when the user help 
buttons are pressed, and what the captions on the buttons say. Records 1A through 1I are 
joined together to create the 
‘Introduction’ help topic, and so on with the other help topics. Having multiple parts to 
each topic is made necessary by the text in each field being limited to 255 characters. 
You can add a new part if you need to extend a help topic. Being able to customize the 
user help topics, enables you to give exactly the instructions you want to your staff. 



 

 

17 

 

The File Menu 
 
The File menu gives you considerable control over the workings of the Aquarius 
database. 
 
Changing databases: 
 
The first three items enable you to choose which database is displayed. Normally you 
will be using the Working database, but you may wish to switch to the Sample database 
so you can experiment with various features without affecting your working data. You 
may also want to temporarily switch to a backed-up database to check some details in it. 
For instance, you may want to look at sales figures from a previous year. It’s as easy as 
clicking on the database you want, and when you have finished, clicking ‘Working 
database’. When you click on  
‘Backed-up database’ , choose the database you want from the open-file dialog box that 
appears. The Window caption changes to include the name and path from ‘AquariusDB’ 
of the loaded file, to remind you that you are not in your normal working database. 
Changes you make to a backed-up database stored in the “AquariusDB \Backup” folder, 
or any folder under “AquariusDB”, will be saved back to the original location when you 
switch back to your Working or Sample database. 
 
Multiple databases: 
 
Being able to switch to any number of backed up databases, and work them just as you 
would your main working database, means you can have multiple databases in Aquarius 
and switch among them at will. To create a new database, back up one you already have 
under a different name (see next section), change to this new database, then use the Setup 
form to customize it, and the forms on the Edit menu to delete the old data and add the 
new. 
 
The last three items on the file menu are useful file utilities: 
  
Backup database allows you to create a copy of the current database under a different 
name, and in a different folder or disk. If you wish to roll over your database at the end of 
your tax year, you can use this to back up the database, for future reference, before you 
delete the sales to start the database afresh for the new year. You should also regularly 
back up your database during the year, just in case you have a hard disk failure or the 
database becomes corrupted due to some other problem. If you have a lot of sales it is 
wise to back up at the end of each day. The first time you backup a database, Aquarius 
makes a new folder called “Backup” within the “AquariusDB” folder, and opens that 
folder for you to save in. Since clicking “Backed -up database” also initially opens this 
folder, it is a good idea to use it for your backups. 
 
If your data is critical, and it would be a disaster to lose even a part of one day’s data, you 
could contact the author of Aquarius Database about adding a ‘transaction logging’ 
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feature to your database, which enables all data to be restored if you have a disk or 
database failure. 
 
Compact database gets rid of the waste space in your database that appears when 
records are deleted or change in size, so your database will occupy less disk space. You 
only really need to do this if size is an issue, and it is a good idea, to be on the safe side, 
to back up the database before compacting it. 
 
Repair database can sometimes repair a corrupted database, so if your database does 
become corrupt, try this before resorting to restoring your last backup. 
 
Restore backup permanently replaces the current database with a named backup that you 
choose from open-file dialog box (you should choose the most recent one). It is very 
different from clicking 
‘Backed-up database’, which is just a t emporary shift. It should only be used as a last 
resort if your database is hopelessly corrupted and 
‘Repair database’ could not fix it. Consequently, you have to pass through two levels of 
warning before this command operates. 
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Importing and exporting data 
 
If you wish to transfer customer and product records from another database, or a 
spreadsheet, chances are that that program will allow you to ‘export’ the data as a 
‘delimited text file’. If you can do this, you will save all the effort of having to re -enter 
the data in Aquarius. 
 
A delimited text file stores one record on each line of the file, each field being 
‘delimited’, s eparated from the next field, by a character which doesn’t appear in any of 
the data. Often the delimiting character is the Tab character, but it could be the ‘*’ or any 
other suitable character. The first line of the file is a ‘header record’ which contai ns the 
names of the fields, separated by the delimiting character. The actual data starts on the 
second line. 
 
You can control the way the data is imported into Aquarius by making changes to the 
header record, and you will probably need to do this. You do it by loading the exported 
file into Word or some other word processor, editing this first line, and saving the file. 
 
Aquarius will only import data from fields whose headers have the same names as 
Aquarius fields. So, basically, you will need to change the header names of fields you 
wish to import, if they are not already the same, to the names of the Aquarius fields you 
wish the data to be placed in. The field names can be any combination of upper and lower 
case. 
 
One complication is that Customers stores the whole name in one field, called ‘Name’, 
rather than in separate fields for FirstName, MI (middle initial) and LastName. The rules 
for handling this are: 
 
1) If there is a field header called ‘Name’, ‘FullName’ or ‘Full Name’, that field will be 
imported as the Name field, and any other Name fields will be ignored. 
 
2) If there isn’t a ‘Name’ or ‘FullName’ header, there must be  
‘FirstName’ and ‘LastName’ (‘First Name’ and ‘Last Name’ OK) headers for fields 
containing the first and last names. There can also be a ‘MI’ (middle initial) header for a 
field containing a middle initial or middle name. Customers will join these together to 
create the data for the Name field. 
 
The other field names are: ‘Company’, ‘Street ’, ‘Town’, ‘State’, ‘Zip’, ‘Country’, 
‘Phone’, ‘Fax’, ‘Email’, ‘Since’ (for a date in mm/dd/yyyy format) & ‘Notes’.  
 
Here is an example of an export file, and how you would modify it to import it into 
Customers: 
 
GivenName*MidName*FamilyName*Phone*Comments*MarStat 
Joe*H.*Bloggs*(123) 456-7890*Great guy*Single 
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Mary*M*Manning*(098) 765-4321*Nice*Divorced 
Lisa*N*Lee*(555) 444-3333**Married 
. . .  
 
Change header to give: 
 
FirstName*MI*LastName*Phone*Notes*MarStat 
Joe*H.*Bloggs*(123) 456-7890*Great guy*Single 
Mary*M*Manning*(098) 765-4321*Nice*Divorced 
Lisa*N*Lee*(555) 444-3333**Married 
. . . 
 
All fields accept for the last will be imported, and the content of the name field will look 
like ‘Mary M Manning’. If you want the name data to be last name first, and loo k like 
‘Manning Mary M’, you would make the header look like this:  
 
MI*LastName*FirstName*Phone*Notes*MarStat 
Joe*H.*Bloggs*(123) 456-7890*Great guy*Single 
Mary*M*Manning*(098) 765-4321*Nice*Divorced 
Lisa*N*Lee*(555) 444-3333**Married 
. . . 
 
If one of these three name fields has the full name in it, Customers will import only the 
word from this field which isn’t in the other two fields. For instance, Customers exports 
its Name field like this: 
 
FullName*FirstName*LastName*Phone*Notes*MarStat 
Joe H. Bloggs*Joe*Bloggs*(123) 456-7890*Great guy*Single 
Mary M Manning*Mary*Manning*(098) 765-4321*Nice*Divorced 
Lisa N Lee*Lisa*Lee*(555) 444-3333**Married 
. . . 
 
Let’s say you switch the name headers around to this:  
 
LastName*MI*FirstName*Phone*Notes*MarStat 
Joe H. Bloggs*Joe*Bloggs*(123) 456-7890*Great guy*Single 
Mary M Manning*Mary*Manning*(098) 765-4321*Nice*Divorced 
Lisa N Lee*Lisa*Lee*(555) 444-3333**Married 
. . . 
 
Note: When you click ‘Export’, the delimited text file is automatically saved in the 
Aquarius folder as ‘AqExpWP.txt’.  
 
When you delete the records, and re-import the file, it will import in the last-name-first 
format of ‘Bloggs Joe H.’. You can use this technique to change the format of your name 
field. 
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To import a delimited text file once you have adjusted the header, click the ‘Import’ 
button and find and open the file. Import will show a message showing how many 
records were imported and how many duplicate or flawed records were not imported. The 
Name field must have at least two words in it, and must be unique — that is be different 
from the name in any other record. Records not meeting these requirements will not be 
imported. For instance, if you try to import the same file twice, without deleting the 
imported records first, Aquarius will reject all the records the second time around. After 
all, there is no point in having duplicate records. 
 

Importing product data 
 
Product data is simpler to import than customer data, as there is not the complication of 
the various parts of the name field. The header must use field names from this list: 
‘Code’, ‘Descr’, ‘Price’, ‘TaxRate’, ‘CriticalStock’, ‘ActualStock’, ‘LastPurchased’, 
‘NumberPurchased’, ‘IntialStock’, ‘Supplier’, ‘Cost’, ‘Ordered’, ‘Stats’ and ‘Picture’. 
Header record fields not in this list will be ignored, and the data in the fields they refer to 
will not be imported. The process is the same as for Customers. 
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Rolling over data at year’s end 
 
If you don’t have a huge number of sales, you can just keep using Aquarius year after 
year without rolling over the data. If, however, you do thousands of sales a year, you may 
want to roll over the old figures and start with a fresh sales database each year. This is 
easy in Aquarius: 
 
1) Use ‘Backup database’ to back up your database to Aquarius’s  
‘Backup’ folder (the default), and give it a name which makes clear the  
year it is for, eg: ‘Arc2003’ (Aquarius will automatically give it the  
‘.mdb’ file extension).  
 
2) In ‘Edit Sales’, hold down the ‘Ctrl’ key while clicking the ‘Delete’ button to get 
global delete. It will ask you if you are sure you want to delete all the sales records. Click 
‘Yes’ and all the sales and item records will be purged from the database, so you can start 
with a fresh sales database for the new year. 
 
3) Before making the first sale of the new year you can specify the first receipt number. 
For instance, you may wish to make the first digit or two correspond with the year the 
sales are being made in. Say you want receipt numbers to start with ‘5’ during 2005. 
Make a ‘dummy’ sale of one of your products. Go to ‘Edit sales’ and change its receipt 
number to 500000. Then when you make the first real sale of the year it will have the 
receipt number 500001, which is what you want. At this point, go back to ‘Edit sales’ and 
delete the dummy sale. You can do this regardless of whether you are starting with a 
fresh sales database for the year or not. 
 
4) If you wish to review sales details or reports from a previous year, you can temporarily 
load that year’s database into Aquarius by going to the File menu, clicking on ‘Backed -
up database’ and selecting the database you want. To return to your working database, 
just go back the File menu and click on ‘Working database.’  
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Using a different word processor 
 
If you don’t have MS Word 97 or later, you may be able to make another word processor 
do the same job of printing invoices, envelopes, labels etc., as long as that word processor 
has the ability to do mail merge. It will be a little complicated, though! 
 
1) Click ‘Setup’ from the ‘Customize’ menu to bring up the setup  
form, and fill in the appropriate details for your word processor in the 
‘Word processor setup’ section (Note 4 on the form helps explain how  
to do this.) 
 
2) You will have to create mail merge files (in the Aquarius folder) for each of the print 
buttons, giving them the same names as the Word ones I created, but with the appropriate 
file extension for your word processor. These are: 
 
‘AqCatalog’ (Addr. List), ‘AqEnvelopes’, ‘AqLa bels’ and ‘AqLetters’ on the 
‘Customers’ form which use the data source ‘AqExpWP.txt’  
 
‘AqInvoice’ and ‘AqReceipt’ for buttons on the ‘Customers’ form, which use the data 
source ‘AqToInv.txt’  
 
‘AqProdCatalog’ for the ‘Make Catalog’ button on the ‘ Edit Products’ form, which uses 
the data source ‘AqExpPro.txt’  
 
All three data sources have one record per line, starting with a header record of field 
names, and delimit the fields within each record with Tabs (i.e. they are the standard Tab-
delimited text files that most word processor mail merge programs like to use as a data 
source). 
 
Aquarius creates the appropriate data source file when you click on one of the buttons, 
overwriting any previous version of it, then uses the information you entered in the Setup 
form to start your word processor, load the appropriate mail merge file, then perform the 
mail merge to produce the final merged document. 
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Extending Aquarius 
 
Aquarius will, as it is, adequately meet the needs of many small businesses and 
organizations. But as these businesses grow and evolve, most of them will, in time, need 
additional features added to their database. Others may need additional functionality right 
from the get-go. A database that cannot evolve with a business will eventually end up 
hindering it and holding it back. As a result of this important database ‘fact of life’, I 
(Aquarius’ author) have made p rovision for the expansion of Aquarius in two different 
ways. 
 
These you will have to pay a moderate price for, but if your business has grown, this 
should not be too much of a burden, especially as you had the use of a free database 
during the early days of your business when the money supply was really tight, and 
continue to have that free use of the basic Aquarius functionality. These ways are: 
 
1) The Extendable version of Aquarius: I am now creating an extendable version of 
Aquarius, which will look and operate in exactly the same way as the Aquarius you now 
have, and work with the exact same data you are now using, but will have invisible 
command buttons and menu items which can, from a setup form, be made visible, be 
given captions, and have programs attached to them. The buttons and menu items already 
present will also be able to be renamed and reassigned to new programs if required. This 
will mean that you or a computer programmer of your choice can write programs to 
manipulate your database in any way you like, in any programming language which can 
work with MS Access databases, and seamlessly splice them into the Aquarius interface 
you are already using. The anticipated price for this extendable version of Aquarius is 
$95.00. 
 
2) Custom programming services: Since I wrote Aquarius in the first place, and am 
intimately familiar with its code, I can easily and efficiently modify the code to make 
changes you want, and so can probably do so more cheaply than most. And I have a 
method that allows me to do this at a distance. After discussing the changes you want, 
you would send me a copy of your database to work on. While I am working on the 
changes you can continue to use your old database. This is because of the way I make 
needed changes to the structure of the database: when I send you the new program, the 
first time it runs it will take your current database and make the required changes to 
structure on the fly, and prompt you to add any new data that may be needed. In short, 
there will be no down time while I program the changes. 
 
To inquire about either of these options, please e-mail me at mark@markmason.net and 
include the word ‘Aquarius’ in the subject line (or phone me on 541 485 -3905). 
 
Other business productivity programs I have written: If you are interested in trying 
my ground breaking TypFast abbreviation expander program, which can greatly reduce 
the number of keystrokes you need to make while typing, then please visit my web page 
for it, www.markmason.net/tf/ to find out more about it and download it. 

http://www.markmason.net/tf/
mailto:mark@markmason.net
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Troubleshooting and updating 
 
If some features of Aquarius are not working correctly, check that you have the latest 
version of Aquarius Database. Click “About Aquarius” from the Help menu to find the 
version you have: “Aquarius Database 1.7” means you have version 1.7. Go to Simtel or 
the author’s website for Aquarius Database, at www.markmason.net/aq/, and see if a later 
version is available. If it is, download the later version. 
 
Before installing a new version, to be on the safe side, backup your working database to a 
different folder or disk (or both). 
 
When installing a new version, if you want to keep the database(s) you have already set 
up (which you probably will want to!), choose NOT to overwrite the files the Setup 
program asks about overwriting – they are the old databases! 
 
Once a new version is installed, click “Working database” from the file menu to return to 
your working database. If you have, by mistake, overwritten your working database 
during the setup process,  you can restore the backup you made. To do this, make sure 
you have “Working database” selected on the file menu, then from the File menu go to 
the “Repair and Restore” submenu and click “Restore backup”.  
 
If Aquarius will not run, please see my web page for the product, 
www.markmason.net/aq/, for ideas on how to get it up and running.  
 
If you are still having problems after having done these things, please e-mail me at: 
mark@markmason.net and put the word “Aquarius” in the subject line – I will be happy 
to know about the problem, and will do my best to fix it or help you overcome it. 

mailto:mark@markmason.net
http://www.markmason.net/aq/
http://www.markmason.net/aq/
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Version History 
 
Improvements in Aquarius Version 1.8: 
 
1) A bug in the new ‘Unpaid Accounts’ report caused the program to crash if there were 
no unpaid accounts to report. This has been fixed. 
 
 
Improvements in Aquarius Version 1.7: 
 
This is a significant upgrade. 
 
1) It includes a new report on ‘Unpaid accounts’, and a whole strategy for keeping track 
of and claiming bad debts. 
 
2) Product codes can now be 13 numerals wide, instead of the previous 11, and still fit 
into the code display boxes. This allows for the longest barcodes I know of. 
 
3) Users can now pick a code from a dropdown list showing codes, descriptions and 
prices in the ‘Make a Sale’ and ‘Add Stock to Inventoy’ windows, instead of having to 
type in product codes. 
 
4) The ‘Make a Sale’ and ‘Find Products’ windows now automatically show extra lines 
of content when they are increased in size by draging their bottom edges down. These 
windows now also keep their new size during the current session.  
 
5) Formatting of the Product Catalog has been improved. 
 
6) It is now possible to change Critical Stock levels from the Purchase Report. 
 
7) Two extra filter choices have been added to Edit Sales to process bad debts & 
customer queries. 
 
8) Only the main Aquarius window now shows an icon in the task bar. Secondary 
windows no longer clutter the task bar and cannot be minimized, nor in most cases 
maximized. This makes using Aquarius much more straightforward and reliable wthout 
sacrificing any utility. 
 
 
Improvements in Aquarius Version 1.6: 
 
1) In Customize-Setup you can now check the ‘Customers button’ box if you want to 
have a button to click on the main window to get to the ‘Customers’ window. The 
‘Customers’ button will replace the ‘Add Inventory’ but ton, and an ‘Inventory’ command 
will appear on the Edit menu instead, in place of the ‘Customers’ command, to allow you 
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to access the ‘Add Stock to Inventory’ window. This is a good change to make if you 
consult your customer file a lot. This is the first of a series of changes I anticipate making 
to make Aquarius more useful in managing organizations with large memberships. 
 
 
Improvements in Aquarius Version 1.5: 
 
This is a significant upgrade. 
 
1) You can now create multiple databases and work them just as you would your main 
working database (see the ‘File Menu’ help topic). Previously you could just view backed 
up databases but any changes would not be saved. Changes are now saved. So now you 
can work any of your backed up databases as independent databases. 
 
2) The Picture field of Product records can now also contain product location information 
that will show with or without the picture in the ‘Product Lookup’ form.  
 
3) Aquarius has been made more robust in a variety of ways, and a few small bugs have 
been fixed. 
 
 
Improvements in Aquarius Version 1.4: 
 
1) There is now no need to set the minimum product code length in Setup. This used to 
be to prevent the “No matching product” message from showing until the user had typed 
in the whole product code, as this message is meant to indicate a wrong code, and if you 
are on the way to typing a correct code, it’s not wrong yet! Aquarius now automatically 
checks to see if the user is on the way to typing a correct code and only shows the “No 
matching product” prod uct description if you make an error, regardless of the length of 
the product code. This means you can use product codes of different lengths if you really 
want to. 
 
2) Increased error checking to prevent operator error. In the Edit Product form, users can 
no longer mistakenly add leading or trailing spaces to product codes: such spaces are now 
automatically deleted the instant they are typed! In the Make a Sale and Add Inventory 
forms users can, likewise, no longer add a leading space to a product code, or truncate the 
product code by not having the typing cursor at the end of the code when pressing Enter 
to move to the next field. In short, possibilities for operator error in these forms have 
been greatly reduced. 
 
3) It is now no longer possible to leave the Price or Cost fields blank when creating a new 
Product record in Edit Products. These fields being blank used to be the cause of a “No 
matching product” message, even when the correct code was typed in.  
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4) The two remaining number fields on the setup form have been error checked to 
prevent Aquarius crashing if numbers in those field are deleted so new numbers can be 
typed in. 
 
 
Improvements in Aquarius Version 1.3: 
 
1) The system file “VB5DB.DLL”  has been added to the package, as it seems to be 
missing on many people’s computers. It will just be kept in the “AquariusDB” folder. If 
you want it in “Windows \System” (its natural home) or elsewhere, so other programs can 
use it, you will need to move it yourself. 
 
 
Improvements in Aquarius Version 1.2: 
 
1) Bugs in the generation of receipts, invoices, envelopes, catalogs, etc., using mail 
merge to MS Word, have been fixed. 
 
2) A message box has been added to explain why product records cannot be deleted when 
there are existing sales including that product. 
 
 
Improvements in Aquarius Version 1.1: 
 
1) The file DBGRID32.OCX, which many people may not have on their computer, has 
been added to the setup package. Without this file, neither of the two reports would have 
worked, but would have given an error message saying it could not find this file, and 
crashed the program. This should never be a problem now. 
 
2) The formatting of the help files on screen resolutions other than XGA (1024 x 768), 
was a little erratic, but still readable, in version 1.0. The formatting is now the same for 
all screen resolutions. 
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